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Problem: 

 South Padre Island, Texas is part of the world’s largest barrier island and the home to 

thousands of individuals in the island. This Barrier Island, is Texas’s first frontier of protection 

from sea level rise and storm surges which also protects the Brownsville-Harlingen 

Metropolitan Area (population: 450,000) from natural disasters.  South Padre Island is also a 

tourism attraction for the state of Texas which not only helps the local economy, but it also 

improves the economy of the state. With global warming increasing through time, and the 

melting of land ice sheets it is clear that this area is threatened by sea level rise. South Padre 

Island, having an elevation of 2 meters above present day sea level, seems to be an area that 

will be strongly affected by sea level rise in the upcoming decades to the next century with a 

possibility of an increase of up to 10 meters above present day sea level. 

 

Goal: 

 The goal is to create a map of South Padre Island using GIS techniques and spatial 

analysis to show how various sea level rises may affect South Padre Island and even the 

Brownsville-Harlingen Metropolitan Area. This map will be accomplished by using raster data to 

create an elevation model, and state urban population data. 

 

 



Data Sources: 

 Texas Natural Resources Information System -https://tnris.org/data-catalog/ 

Acquired shape-files: 

1. Txdot_county_detailed.shp = Outline of the State of Texas 

2. Txdot-city-poly-2014-94 = Location of large urban areas in Texas 

3. Dataframe shape-file 

4. Shoreline shape-file 

5. Topography shape-file 

6. Bathymetry shape-file 

7. Geographic names shape-file 

Acquired raster files:  

1. BaseMap.img  

2. Raster: NED13-10m_2597.dem 

3. Raster: NED13-10m_2697.dem 

 

 

 

 

  



Methods:  

1.) After obtaining all the necessary data, I added the data to a blank map in ArcMap 

and checked that all data obtained had the same projection.  In this case, all the data was 

already set to a Coordinate System of WGS 1984 which is the 1984 World Geodetic System 

nearly identical to NAD83. 

 



2.) The first step to create my map was to add the shape file from TNRIS called 

txdot_county_detailed.shp which gave me the outline of Texas, its barrier island and the outline 

of the Texas counties. 

 

 

 

 

 

 

 



3.) In order to show the largest urban areas in Texas, I added the txdot-city-poly-2014-

94.shp shape-file. This shape-file will allow me to show large urban areas near South Padre 

Island such as the Brownsville-Harlingen Metropolitan area. 

 

 

 

 

 

 

 

 



4.) To be more familiar with the cities near my area of interest, I decided to label all the 

major cities in the state of Texas by using the label features tool. 

 

 

 

Click on Txdot-city-poly-2014-94 > right click on mouse > select label features 

 

 

 

 

 



5.)  The next step was to zoom in ArcMap to the best possible view to be able to show 

the area of interest for this project. For this project, I will focus in the sea level rise for the area 

of South Padre Island as well as the Brownsville-Harlingen Metropolitan Area.   

 

 

 

 

 

 

 



6.) After realizing that the view I had previously was not the best, I decided to zoom out 

a small portion in order to be able to add a frame shape-file and a map area shape-file. These 

files will allow me to separate my zone of interest in the map from other areas that I will not be 

assessing in this project. 

 

 

 

 

 

 

 



7.) My next step was to add a base map image shape-file (BaseMap.img). This shape-file 

allowed me to show the Gulf Coast of Texas in a better representation from what I previously 

had in my map. Even though this base map image was obtained from the same source it was 

downloaded from another file (TNRIS State Bathymetry), but it was already georeferenced with 

my ArcMap data. 

 

 

 

 

 



8.)  To have a better outline of the coastal shores and inland shores, I added a shoreline 

shapefile. This shoreline shapefile will serve as a reference point once I project sea level rise. 

This shapefile also serves to distinguish the border with Mexico by showing the Rio Grande. 

 

 

 

 



9.) At this point I decided to zoom in to ArcMap to a view that focused on South Padre 

Island and the Brownsville-Harlingen Metropolitan Area. Since the base map image shape-file 

covered the (txdot-city-poly-2014-94.shp) shape-file which shows the Brownsville-Harlingen 

Metropolitan Area, I moved the shape-file (txdot-city-poly-2014-94.shp) to the top of the layers 

in the TOC to be able to see it. 

 

 

 

 

 



10.) Since I was able to obtain a topography shapefile from TNRIS that contained 

topography for my area of interest in meters, I decided to add that shape-file to ArcMap. The 

topography shape-file only had a range of topography and my area of interest contained two 

contour lines that belong to two ranges. I decided to change the color of my contour lines that 

belong to the range 1-10m to a reddish/brown color and the contour range from 11-20m to a 

lime green color. To label the contour lines I used the label features tool. 

 

 

Click on Topography> right click on mouse > select label features 

 



11.) In order to still be able to show the Brownsville-Harlingen metropolitan area along 

with the topography, I had to move the (txdot-city-poly-2014-94.shp) shape-file above the 

topography shapefile in the TOC.  To have a better view of the topography and the urban areas 

I had to change the transparency of the shape-file (txdot-city-poly-2014-94.shp) to 40%. 

 

  

 

 

 

 

 



 12. Next I decided to add a bathymetry shape-file of the Gulf of Mexico to show the 

sea elevation in my map. I labeled the bathymetry using the label features tool.

 

 

 

Click on Bathymetry> right click on mouse > select label features 

 

 

 

 

 

 

 



 13. To make the map more geographic identifiable, I added a shapefile from TNRIS 

(Geographic_Names.shp) to ArcMap that contained a few of the most important geographic 

names to features in the Gulf of Mexico. 

 

 

 

 

 

 

 



 14. The crucial part was to show the sea level rise in the coast of South Padre Island. 

To be able to show sea level changed, I needed to obtain a digital elevation model (DEM) of my 

area of interest. It was important to find a DEM that had a 10 meter resolution in order to have 

the best possible resolution of South Padre Island and the Brownsville-Harlingen Metropolitan 

Area. TNRIS had two DEM rasters of my area of interest that I stitched together by using the 

mosaic tool.  This tool stitches together different DEM rasters into one raster. As I stitched the 

two rasters togethers I made sure that the spatial reference for the new raster was what I 

needed which was GCS_WGS_1984. 

 

(ArcToolbox > Data Management > Raster > Raster Dataset > Mosaic to New Raster) 

 

 

 



 15.) I then added the stitched DEM raster (mosaic 1) below the base map image in the 

TOC. Since the color of the base image and the Dem raster was dark, I had to set the 

transparency of the Base image to 50%. This transparency will give a better visual 

representation between the base image and the DEM raster. At this point I realized that my 

map seemed to be very crowded and there was no need show topography and bathymetry so I 

decided to turn off those two shape-files. The best way to represent elevation will be instead to 

change the color of the DEM to colors that reflect topography and adding a hill-shade to the 

map. This will be done later in the process. I also wanted to show the counties, and a full border 

between the U.S. and Mexico so the next step was to move the shapefile that contained the 

outline of Texas and its counties to the top of the TOC, give it a hollow color in order to just be 

able to see the counties and border boundaries. 

 

 

 



 16.) Next I needed to clip the Base map image (BaseMap.img) to the size of the DEM 

raster (mosaic (1)). This process of clipping would allow me to have a map of just the area of 

interest and exclude the areas not shown in the map. For the input data I used the 

(BaseMap.img), and the output was set to the DEM raster area (mosaic (1)).

 

 

ArcToolbox>Data Management Tools>Raster>Raster Processing>Clip 

 

 

 

 

 

 

 

 



 17.) The image below was my result after the clipping process. The (Base_clip) raster 

contains only the area of interest from the (BaseMap.img) 

 

 

 

 

 

 

 

 

 

 

 

 

 



 18.) Since I had decided not to use the topography and bathymetry shape-files I had 

earlier acquired, a hillshade raster from the DEM was created to make my map show 

topography and make it look more 3D. I used the Hillshade tool from ArcToolbox to make this 

possible and used the DEM raster (mosaic (1)) as the input raster. 

 

 

ArcToolbox>Spatial Analyst tools> Surface > Hillshade 

 

 

 

 

 

 

 



 19.) The image below shows the result of the hillshade. I decided to turn of the 

(Base_clip) raster because the (BaseMap.img), the DEM raster (mosaic (1)), and the hillshade 

gave the best visual representation. I also changed the color of the DEM raster to have a better 

color scheme that showed topography. 

 

 

 

 

 

 

 

 



 20.) To show changes in sea level rise, I had to use the raster calculator to subtract 

the amount of meters I wanted the sea level to rise from the DEM elevation raster (mosaic(1)). 

The equation used is shown in the picture below with an example of rise in sea level by 1 meter. 

 

 

ArcToolbox>Spatial Analyst Tools>Map Algebra>Raster Calculator 

 

 

 

 

 

 

 

 



 21.) The result of the raster calculator process is shown in the image below. The 

image below represents sea level rise of 1 meter from the current sea level conditions 

 

 

 

 

 

 

 

 

 

 

 

 



 22.) To show only the sea level change and keep the original mosaic I changed the 0 

meter land elevation to hollow and just left the 1m sea level rise. The same process was 

repeated to show all other sea level changes as well.  

 

 



 23.) At this point, my map was mostly completed, but I decided to fix small details. To 

make the county and border boundaries more noticeable I increase the width in the symbol 

selector. 

 

 

 

 

 

 

 

 

 

 

 

 



 24.) The names of the counties shown in my area of interest, the Gulf of Mexico and 

Mexico were added to the map by using the text tool from the drawing tool bar.  Results are 

shown in both images below. 

 

 



 25.) My last step was to set the reference scale of my map to 1:625,000 since at this 

scale it seemed to show the best possible visual representation of my area of interest without 

causing any distortions.

 

 

 

 

 

 

 

 



Conclusion:  

 By using raster and vector data such as DEM’s and shapefiles, ArcMap has allowed me 

to create 10 maps showing how up to 10 meters of sea level rise can affect South Padre Island 

and the Brownsville-Harlingen Metropolitan Area. With the tools available in ArcToolbox and 

the experience of using ArcMap in class, I was able to create a hazard map that shows sea level 

rise needed to negatively affect South Padre Island and the Brownsville-Harlingen Metropolitan 

Area. 

 My map projections show that just 1 meter of sea level increase can harshly impact 

the Texas Gulf Coast. With 1 meter of sea level rise a small portion of Padre Island will be under 

sea level and quite a few cities in the mainland will also be affected. With 2 meters of sea level 

increase most of South Padre Island will be under sea level and the Brownsville area will begin 

to see the effects of sea level rise. By the time 5 meters of sea level increase, South Padre Island 

will completely be under sea level as well as half of Brownsville city. Once sea level rise reaches 

10 meters, Harlingen city will also be affected. 
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